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Experiment 13:  Determination of Molecular Weight by 
Freezing Point Depression 

 
Objective:  In this experiment, you will determine the molecular weight of a compound 
by measuring the freezing point of a solution of the compound and then comparing the 
freezing point of that solution to that of the pure solvent. 
 
Introduction 

 The properties of a solution differ from those of a pure solvent due to interactions 
that take place between the solute and solvent molecules.  The properties that exhibit 
such changes are called the colligative properties and include vapor pressure lowering, 
boiling point elevation, freezing point depression and changes in osmotic pressure (see 
Tro, section 13.6-13.7 pp 593-608).  These properties are dependent only upon the 
number of particles (ions or molecules) that are dissolved in the solvent and not on the 
identity of the particles.  This experiment will examine the phenomenon of freezing point 
depression. 

 When a particular solute is dissolved in a solvent, the following expression holds 
true: 

ΔT = Tf° – Tf = Kfm 

The terms Tf° and Tf refer to the freezing-point temperatures of the pure solvent and the 
solution, respectively.  The term “m” indicates the molality of the solution, which is 
defined as the number of moles of solute per 1000 g of solvent.  This quantity is used, 
rather than molarity, because it is not temperature dependent.  The constant, Kf, is 
referred to as the freezing-point-depression constant and is dependent only upon the 
solvent.  The change in temperature is also dependent upon the number of solute particles 
in solution— the more particles that are present, the larger the change in temperature.  
For this reason, the above equation is sometimes written as: Tf° - Tf = Kfim, where  
i = the number of solute particles produced per formula unit that dissolves.  In a solution 
containing an electrolyte, each ion is considered to be a particle.  You will explore the 
influence of i on the freezing point depression in Part II of the experiment. 

 In Part I of the experiment, you will use cyclohexane, an organic compound that 
is a liquid at room temperature, as the solvent.  You will be able to determine the 
molecular weight of an unknown compound by observing the freezing point of a solution 
of the compound in cyclohexane and comparing it to the freezing point of pure 
cyclohexane.   

Calculations  

1.  The compound cyclohexane has a melting point (or freezing point) of about 
6°C.  You will obtain a series of temperatures of pure cyclohexane as it cools 
down from room temperature through its freezing point in an ice bath.  These 
temperatures will be plotted as a function of time.  Similarly, you will obtain 
temperatures of a solution of an unknown compound in cyclohexane as it cools 
down to the freezing point, which will also be plotted.  The plots will look 
similar to those pictured in Figures 1a and 1b, and the Tf° and Tf values can be 
extrapolated from them as shown on Figure Page 1, Expt. 13. 
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2.  The molality of a solution can be expressed in terms of the molar mass of the 
solute: 

€ 

m =
moles of solute
1 kg of solvent

 

 
 

€ 

=
(1000 g/kg) ⋅ (g of solute)

(molar masssolute,  g/mol) ⋅ (g of solvent)
 

 
Substituting this expression into the equation for freezing-point depression we 
obtain: 

 
    Eq. 1 

  
 

 For cyclohexane, Kf = 20.2 deg⋅kg/mole of solute.  Recall that the molecular 
weight (in amu) of a substance has the same numerical value as its molar mass.  
 
 In Part II of the experiment, you will measure the change in temperature when 
urea, CON2H4, is added to a mixture of ice and water and compare it with the change in 
temperature observed when sodium chloride, NaCl, is added to an ice-water mixture. 

€ 

=
(g of solute/molar masssolute,g/mol)

(g of solvent) • (kg/1000 g)

€ 

f
o

ΔT=T − fT =
(1000 g/kg) ⋅ ( fK ) ⋅ (g of solute)

(molar masssolute,g/mol) ⋅ (g of solvent)
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Procedure  (you do not need to outline instructions for using the LoggerPro software) 

 A temperature probe interfaced to a computer will be used to acquire the 
temperature readings in this experiment.  Two students will use the same computer, but 
each student will have his/her own temperature probe and will obtain his/her own set of 
data to evaluate.  Two temperature probes should already be plugged into the LabQuest 2 
interface.  Choose a temperature probe and record the number of the channel into which it 
is plugged. You must use the same probe for all measurements.  The temperature probes 
have an uncertainty of ±0.1°C. 

 To log onto the computer, type “student” for the name and type “chemistry” for 
the password, then click on Log In.  Click on the Applications folder at the bottom of 
the screen.  In the window that opens, click on the button labeled Logger Pro to open the 
Logger Pro software.  When two temperature probes are plugged into the LabQuest 2 
interface, the following picture should appear on the screen: 

 

 Pull down the Experiment menu and choose Data Collection….  Change the 
length of the experiment to 800 seconds.  The Sampling Rate should be set to  
1 samples/second.  Click on Done.  Click once on the number at the very top of the y-
axis.  Type in 40 and press return. You are now ready to collect data. 

 Wear safety glasses at all times. 

 The computer will collect the data for both your and your partner's temperature 
probes simultaneously; therefore, you should carry out the steps of the experiment at 
approximately the same time.   

Part I. Determining the Molecular Weight of an Unknown Compound 

Wipe the temperature probe with a paper towel to be sure it is dry.  Assemble 
your apparatus as in Figure 2, shown on Figure Page 2, Expt. 13.  A 16x150 mm test tube 
will be provided for you.  The test tube must be clean and dry!  Insert the stopper with 
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the temperature probe and wire stirrer into the test tube.  The stopper should not extend 
further than halfway into the test tube.  If it can be inserted further than halfway, you are 
using the wrong size test tube.  Be sure that the temperature probe is pushed down as far 
as possible, and that it does not touch the sides or bottom of the test tube. 

Part I.A.  Measuring the Freezing Point of the Solvent 

 Caution!  Cyclohexane is a flammable solvent.  Carefully dispense 12.0 mL of 
cyclohexane into the 16x150 mm test tube from the dispensing bottle.  Raise the piston of 
the bottletop dispenser slowly and evenly to the stop to fill the dispenser, then press down 
slowly and evenly to discharge the liquid into the test tube.  Calculate the mass of 
cyclohexane that was dispensed (C6H12, density = 0.779 g/mL).  Place the stopper with 
the temperature probe and stirrer in the test tube, and set the test tube in a test tube rack.  
Be sure that the wire stirrer moves freely in the test tube and that the tip of the probe is in 
the center of the volume of liquid. 

 Fill the largest beaker from your drawer about one-third full of water, and add ice 
until the beaker is three-fourths full.  When both you and your partner are ready, click on 
the green arrow button, and the computer will begin to collect temperature readings.  
Move the test tube from the rack into the ice-water bath, and hold it such that the level of 
liquid in the test tube is below the level of water in the bath.  Immediately begin stirring 
the liquid continuously and at a constant rate until the entire mass has solidified.  Once 
freezing begins, as long as liquid and solid are both present, the temperature will remain 
constant until the entire mass has solidified.  Agitation will prevent the “supercooling” 
that occurs just before crystals appear.  Allow the computer to continue recording the 
temperature until the plot has leveled off at a constant temperature (see Figure 1a).  Note:  
Once the cyclohexane has frozen solid, the temperature will start to decrease again. 
 
 When you have collected a sufficient amount of data, click on the red button.  
Remove the test tube from the ice-water bath and let it warm up to room temperature.   

Important step!  Saving your data: 
• Save your data by pulling down the File menu and selecting Save As... 
• In the dialog box that appears, the word Documents should be displayed in 

the drop down menu in the middle of the box.  If it is not, scroll through the 
menu on the left, and choose Documents. 

• Next to the words Save as:, type over the word “untitled” with the name of 
your file (example: FPcyclohexaneLAO).  You should include your initials in 
the name you choose. 

• Click on Save.   
• To find your file later, you will have to go to the Documents folder.  It should 

have the suffix .cmbl at the end of the file name. 

 You can now adjust the parameters on the graph.  To view just one of the plots 
(yours or your partner's), click and hold on the y-axis label.  Select Temperature 1 from 
the pop-up menu.  Click on the AutoScale button in the Toolbar, which looks like this:  

 The computer will choose maximum and minimum values for the x- and y-axes 
such that the plot fills the graph completely.  If you do not like the limits for the axes that 
the computer has chosen, it is possible to change them by simply clicking once on each of 
the numbers at the ends of the axes, typing in the desired limits and pressing return.  It 
will be easier to determine the value for Tf later if the y-axis limits are whole numbers.  
Choose the maximum values to be slightly greater than the highest temperature or time 
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recorded, and choose a temperature minimum that is slightly lower than the lowest 
temperature.  The minimum time recorded should be 0 seconds.   

 You can adjust other graph parameters in the Graph Options… found under the 
Options menu.  Be sure that a check mark appears in the box next to Connect Points, and 
type in an appropriate title for the graph in the box under Title.  Your initials should 
appear in parentheses at the end of the title (so you can identify your printout).  Click on 
OK.   

 To print the graph, pull down the File menu and choose Printing Options….  
Click in the box next to Print Footer to make sure a check mark appears, then type in 
your name (and a comment about the plot, if desired).  Now pull down the File menu and 
choose Print Graph… (not Print…).  Click on OK.  In the next dialog box, click on 
Print.  The printer is located in a corner of the lab.  Your name should appear at the 
bottom of the page. 

 Repeat the procedure for adjusting and printing the second plot, this time 
selecting Temperature 2  from the y-axis  pop-up menu.  Be sure to change the title, this 
time putting the second person’s initials at the end. 

 It is possible to print the table of time and temperature readings that the computer 
collected, however, it is not necessary to do so for this experiment.  If for some reason 
you would like a printout of the data, choose Print Data Table… from the File menu. 

Part I.B.  Measuring the Freezing Point of the Solution 

 Obtain from your instructor an unknown compound in a test tube and record its 
number.  Accurately weigh about 0.14 g of this solid material onto a piece of weighing 
paper.  The cyclohexane contained in the test tube should have re-melted by this time.  
Remove the stopper from the test tube and carefully add the unknown sample to the 
cyclohexane while avoiding the loss of any compound adhering to the sides of the test 
tube or stopper.  Replace the stopper and re-weigh the paper to account for any crystals 
which remain on it.  Return the test tube that contains unknown compound to your 
instructor. 

 Stir the solution in order to dissolve the solid.  If necessary, place the test tube in 
warm water from the tap to aid in dissolving the solute.  It is important that no crystals 
remain.  Do not use a hot plate or light a Bunsen burner!  Cyclohexane is flammable! 

 Make up a new ice-water bath, if necessary.  Pull down the Experiment menu 
and select Store Latest Run.  Under the Data menu, choose Hide Data Set followed by  
Run 1.  You can now collect a new data set.  Click once on the number at the end of the  
x-axis, type in 800 and press return.  Click once on the number at the bottom of the  
y-axis, type 0 and return, then click on the upper limit, type 40 and return.  Select All of 
the Above from the y-axis pop-up menu.  When both you and your partner are ready, 
click on the green button.  Place the test tube in the ice-water bath, as in Part I.A., and 
stir the solution continuously and at a constant rate.  The temperature will not remain 
entirely constant as the solution freezes.  The freezing point of the solution, however, is 
the point at which it first begins to freeze and is indicated graphically by a change in the 
slope of the temperature-time curve (see Figure 1b).  You will need to collect data for 
300-500 seconds in order to see this clearly. 

 When you have finished collecting data, click on the red button.  Now you must 
save your data immediately.   
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 Follow the procedures given above to save, adjust, re-title and print your plot. 

 Do not throw any cyclohexane or unknown compound down the sink.  Pour 
the liquid mixture into the Laboratory Byproducts Jar provided by your instructor, then 
rinse your test tube and temperature probe with acetone to remove the last traces of any 
crystals, pouring the rinses in the Byproducts jar. 

Part II.  Comparison of Covalent and Ionic Compounds 
 
Pull down the Experiment menu and select Store Latest Run.  Under the Data 

menu, choose Hide Data Set followed by Run 2.  Change the limits on the x-axis to 0 
and 800, and change the limits on the y-axis to –10 and 10.  Select All of the Above from 
the y-axis pop-up menu.   

 
Weigh 1.0 g of urea onto weighing paper.   
 
Place approximately 20 g of ice in a 150 mL beaker, then add 10 mL of deionized 

water.  Record the total weight of ice and water.   
 
Place the temperature probe in the ice-water slush, and when both you and your 

partner are ready, click on the green button.  Using the temperature probe, stir the slush 
continuously for 2 minutes.  Add the 1.0 g of urea to the slush and continue to stir for 
another 5 minutes.  Click on the red button to stop the data collection. 

 
Save the data file, then choose Store Latest Run under the Experiment menu. 
 
 Weigh 1.0 g of sodium chloride onto weighing paper.   
 
Pour the contents of the 150 mL beaker into the sink, then rinse the beaker and 

temperature probe thoroughly with water.  Weigh 20 g of ice into the beaker, and add 
enough water such that the total weight equals the total weight of ice and water used 
above.  Place the temperature probe in the slush, click on the green button, and stir the 
slush for 2 minutes.  Add the 1.0 g of sodium chloride to the slush and continue to stir for 
5 minutes.  Click on the red button.  Save the data, then choose Store Latest Run under 
the Experiment menu. 

 
Print the graph with the urea and sodium chloride plots displayed simultaneously.  

Indicate on the printout which plot corresponds to which solid. 
 
Pour the contents of the 150 mL beaker into the sink, then rinse the beaker and 

temperature probe thoroughly with water. 

 If you would like to view one of your earlier plots, simply pull down the Data 
menu and choose Show Data Set followed by the Run # that you wish to display.  It is 
possible to have several sets of data displayed simultaneously.  The Runs are numbered 
sequentially in the order in which they were acquired, with the most recent Run being 
called Latest.  Simply use the Hide Data Set and Show Data Set commands to view the 
desired plot or plots. You may have to re-adjust the plot display parameters (such as axes 
scales, etc.).  Use the y-axis label to display one or both students’ temperature plots, as 
desired.  Options also appear under the Data menu to delete one or more sets of data. 

 If at any point you have trouble displaying or printing the proper plot or axis limit, 
try the following:   
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1. Click on the y-axis label and select More…. 
2. In the window that appears, scroll through the list, clicking on the boxes until the 

box(es) corresponding only to the data that you wish to display has/have a check 
mark. 

 When you are ready to leave, pull down the Logger Pro menu and choose Quit 
Logger Pro.   

You should leave the laboratory with printouts of all the necessary plots that you 
produced today.  However, you should also store a copy of your data file(s) by e-mailing 
the file(s) to yourself.  If you need to adjust any of your plots after your lab period is 
over, you can use the computers in the chemistry teaching labs when the rooms are not 
occupied (M and W at 9:00 – 1:00 and Tu, Th at 12:00 –1:15). 
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Calculations 

1.  Determine Tf° for the pure cyclohexane and Tf for the unknown solution from the 
printouts of your plots as shown in Figures 1a and 1b on Figure Page 1, Expt. 13. 

2.  Calculate the molecular weight (in amu) of your unknown using Eq. 1. 

3.  What was your code number?  Identify your unknown compound from the 
following list and explain your conclusion. 

    
Biphenyl; (C6H5)2 

  4-Bromochlorobenzene; Br(C6H4)Cl 
  Naphthalene; C10H8 
 
 Calculate your percent error for the molecular weight of your unknown: 

 % error = ⏐accepted value – experimental value⏐   x  100 
accepted value 

4.  a)  Calculate the molalities of the urea and sodium chloride solutions.  To do this, 
use the mass of slush (ice plus water) and the mass of solute (urea or sodium 
chloride) that you measured.    

b)  Determine the ΔT’s for the urea and sodium chloride solutions, using the 
lowest portion of the plots to determine Tf (see Figure 3 on Figure Page 2, 
Expt. 13).   

 

Questions 

1.  A student’s unknown compound contained an impurity that is insoluble in 
cyclohexane.  What is the effect on the molecular weight determination?  Explain. 

2.  Why is molality not temperature dependent while molarity is temperature 
dependent? 

3.  a) Thoroughly discuss why the values of ΔT for the urea and sodium chloride 
solutions are different.   

b) A spike in temperature is often seen in the plots from Part II when the solid is 
first added to the water (Figure 3 on Figure Page 2, Expt. 13).  Provide a 
possible explanation for this initial increase in temperature (see Chapter 13 in 
Tro), and then describe an experiment that would allow you to test your theory.  

4.  List possible sources of error in Part I of this experiment and for each, indicate 
whether the effect would be an erroneously high or low value for the molecular 
weight of the unknown. 

 


